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Welcome to the evolution of print

Print Specifications & Artwork Setup Guide

This is a guide for those with a basic knowledge of Adobe
Indesign, Illustrator and Photoshop who want to setup
their artwork properly for printing.
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1.0 Print Specifications

All images must be saved in CMYK are at a minimum of 300 DPI
at print size.

Ensure a minimum of 0.25 point is used for stroke width when
printing with EPLOT.

Ensure that you have set up your document to print CMYK.

For Business Cards, Flyers/Cards & Brochures:

Supply all files with 3mm bleed
Try to allow for a minimum of 5mm margin

Provide a ‘Press Ready’ PDF with crop marks

For Perfect Bind:

Supply all files with 3mm bleed
Try to allow for a minimum of 5mm margin
Provide a ‘Press Ready’ PDF with crop marks

Supply outside cover and inside cover in onePDF according to
this order: p1 outside cover with spine - p2 inside cover

Supply internal pages as a single page PDF and not spreads.

Eplot can provide you with a spine width based on the number of
pages and thickness of the stock within your document.

For Saddle Stitch:

Supply all files with 3mm bleed
Try to allow for a minimum of 5mm margin
Provide a ‘Press Ready’ PDF with crop marks

Supply cover & text as a single PDF with individual pages and not
spreads.

The total number of pages must be divisible by 4
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1.1 Standard Size Guides

BC-90 x 55mm

DL -210 x 99mm
A6 —148 x 105mm
A5 —210 X 148mm
A4 —297 x 210mm
A3 — 420 x 297mm

Wide Format

A2 —594 x 420mm
Al- 841 x 594mm
A0 -1189 x 841mm

Brochure

For roll fold, any panel to be folded in should be at least 2mm shorter,
this does not apply to z-fold.

4pp DL (short edge fold) - finish size DL, flat size 420x99mm
4pp DL (long edge fold) - finish size DL, flat size 198x210mm

6pp DL (long edge fold) - finish size DL, flat size 297x210mm -
panel size 97-100-100

8pp DL (long edge fold) - finish size DL, flat size 394x210mm -
panel size 96-98-100-100

4pp A6 (long edge fold) - finish size A6, flat size 210x148mm
4pp A6 (short edge fold) - finish size A6, flat size 296x105mm

6pp A6 (long edge fold) - finish size A6, flat size 313x148mm - panel
size 103-105-105

8pp A6 (long edge fold) - finish size A6, flat size 414x148mm - panel
size 101-103-105-105

4pp As (long edge fold) - finish size As, flat size 296x210mm
4pp As (short edge fold) - finish size As, flat size 420x148mm

6pp As (long edge fold) - finish size 210x143, flat size 427x210mm -
panel size 141-143-143

4pp A4 (long edge fold) - finish size A4, flat size 420x297mm
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1.2 Getting Started - Choosing the right application

Adobe Photoshop

1. Good for handling images and photos, adding special effects and
adjusting colour

2. Not good for dealing with text, vectors and layout.

Adobe Illustrator
1. Good for creating logo, icons and vector based artworks

2. Good for layout single page flyer/business cards

Adobe Indesign
1. Use for books / flyers / business cards

2. Good for combining elements from pdf, illustrator and photoshop
to create the final artwork.
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1.3 Creating a document in Indesign

: . Print-File
Use 3,5 or 10mm margins depending on

artwork requirements and 3mm bleed, you
can create your artwork with full bleed . 210mm Millimeters
(border-less) and all the text will be in a
safe position without being cut off.

For a saddle stitch book, the number of
pages must be a multiple of 4, outside
cover and inside cover must be included as
a single PDF according to this order:

« pl Front cover

« p2Inside front cover

« Content pages (multiple of 4)
« Inside back cover

« Back cover .
10 mm ~ 10mm

Note: If cover is printed outside only, C 10mm ~ 10mm
please keep the inside cover pages as blank
in the PDF.

See example of Indesign file setup with
A4 page size and 10mm Margins, 3mm
Bleed

. 3mm .~ 3mm

~ 3mm - 3mm

. 0Omm

0 mm
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1.4 Bleed

Black line = Actual document finish size
Red line = 3mm bleed
Purple line = margin

@ without bleed @ with 3mm bleed

All backgrounds and images should extend to the bleed line so
that artwork is full bleed after trimming.
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1.5 Border

[f there is a border in any form, please
allow at least 5 -10mm margin so it won't
look uneven after the artwork is trimmed.
[f it is a solid colour or patterned border,
please extend to the red bleed line.

© ©

10mm solid colour border @ 2mm solid colour border,
too thin for trimming
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1.6 Margin

Ensure you keep all important text —

and logos inside the purple margin — P L.I
line so that they won't be trimmed
off or hidden by the spine.

Logo is safely placed

Purple line = 10mm margin line within the margin.

(books) 3mm margin (BC/flyer/
brochure)

| 0|

Logo is at risk of
being cut off.

=PLOT

Logo will definitely
be cut off.
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1.7 Brochure Setup

Here is an example of a roll fold 6ppDL
setup, artwork size is 297x210mm, panel
size 97-100-100, you can choose facing
pages so that the margin on the page 2 will
be flipped, unlink the margins and type

in the custom inside and outside margins.
[fitis a z fold job, set columns as 3 with
gutter and margins as 0, then the panels

will be equally divided.
97 — 100 — 100
back front

Brochure

2794 mm Millimeters

2159 mm

0233 mm

0 mm . O0mm

97 mm 100 mm

3 mm

0 mm . O0Omm

0 mm ~ O0Omm
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1.8 Perfect Bind Layout

Different paper stocks have different thicknesses. Even with the

same gsm weight, uncoated stock is generally thicker than coated

stock. Please consult with EPLOT on the spine thickness of the

specific stock you are printing on.

After defining the spine thickness, you can then create your cover

artwork.

e A4 Portrait = 210+210+10 = 430X297mMm
« As Portrait = 148+148+10 = 306x210mm
« As Landscape = 210+210+10 = 430X148mm

For a perfect bound book, please supply outside cover and inside
cover as a single PDF according to this order p1 outside cover - p2

inside cover.

Back Cover

sutdg

Front Cover
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1.9 Saddle Stitch Layout

« A saddle stitch book must be in a multiple of 4 pages.

« Ifthe coveris printed outside only, a blank page must be present
when you set up the artwork.

« Cover and text should be send together in a single pdf

Above is an example of a 8pp saddle stitch artwork.

=PLOT

eplot.com.au



Welcome to the evolution of print

2.0 Vector & Raster

Vector graphics (Illustrator/Indesign)

A Vector graphic is made up from lines or shapes, which can be sized
and scaled limitlessly without losing resolution or quality.

Raster images (Photoshop)

A raster image is composed of millions of tiny squares called pixels.
Higher dpi (dots per inch) settings (eg 300dpi) will contribute to larger
files. A lower dpi setting (eg 75dpi) will cause pixilation to occur and
the image will become blurry. The minimum dpi set for printing with
acceptable print quality is 150 to 200dpi.

VECTOR RASTER
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2.1 Overprinting

Overprinting refers to the process of printing one colour on top of
another. It is commonly used for knockout or special effects like
white ink. A knockout removes a portion of the bottom image, ie. the
bottom colour is knocked out (not printed) in the area where the top
colour overlaps.

Overprint can be switched on/off from:
Indesign: Window > Output > Attributes
[llustrator: Window > Attribute

Overprint off Overprint on
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2.2 Special Effects

Spot Varnish or White

How to set up your special finish:

Create new spot colour swatch within your document for each print
technique and label as per below:

« Spot Matt Varnish: “NexPress DryInk clear”

«  White Ink: “White”

« Pink Fluroscent Ink: “Pink”

E' P L.t eplot.com.au



Welcome to the evolution of print

2.3 Spot colour/Pantone

Spot colour is a standardized colour reproduction system. EPLOT
can refer to the Pantone system to make sure colours match the
same standard by mixing different ink in a specific formula. It is
usually used for company logos and corporate colours to ensure all
the printed materials match the same colour.

There are various Pantone books on the market. The most commonly
used is, Pantone Solid Coated. All the production grade printers have
their own pantone matching system built-in to mix the 4 colours of
CMYK to the best match of Pantone book. If the colour is critical, you
can pay extra to mix the ink specifically and setup the artwork as a 5
colour job to achieve the best result.
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2.4 Outline Fonts

Ensure all of the document fonts are embedded within the PDF, or
where possible please convert your text to outlines.

To outline fonts: Illustrator/Indesign: Type > Create Outline

Note: Always save a backup copy before you outline fonts in case you
need to make any changes later on.

2.5 Missing Links

[f you have missing links from your Indesign file, it will result in low
resolution print. Indesign will only output thumbnail quality if there
are links missing. Please make sure all images are correctly linked
before generating your pdf for printing.
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2.6 Colour Settings

To ensure colour is matched exactly, change the settings in Indesign

or [llustrator to match below:

Color Settings

Unsynchronized: Your Creative Cloud applications are not synchronized for
‘, consistent color. To synchronize, select Color Settings in Bridge.

Settings: tom

Advanced Mode

Working Spaces

Color Management Policies
Pre Embedded Profiles
:‘2: CMYK:  Preserve Numbers (Ignore Linked Profiles)
Profile Mismatches: Ask When Opening
Ask When Pasting

Missing Profiles: Ask When Opening

Conversion Options
Engine: Adc

Intent: Rel olorimetric

Use Black Point Compensation

Description:

Position the painter aver a heading to view a descripbion.

Step One
Edit > Colour Settings

Step Two
Change ‘Working Spaces'’ to:

RGB: sRGB IEC61966-2.1
CMYK: Euroscale Coated v2

=PLOT

eplot.com.au



Welcome to the evolution of print

2.7 Creating a Press Ready PDF

Producing a Press Ready PDF for print can save you money, time and
headache. It will reduce excess image resolution to printing standard
and produce a PDF with optimum file size. [t can eliminate the need
for any prepress work, therefore increasing the efficiency of your
print job. Follow these steps to export your Press Ready PDF:

Export Adobe PD

Compatibility:  Acrobat 5 (PDF 1.4)

General

[te it Use these settings to create Adobe PDF documents best suited for
high-qualty prepress printing. Created PDF documents can be opened
with Acrobat and Adobe Reader 5.0 and later.

Pages
o Al
O Ran... |All Pages

o P a O Open in Full Screen M...

Options

] Embed Page Thumb... [ View PDF after Export...
i

ble & Printable Layers

(] Non-Printing Gbje...

[ Visible Guides and Baseling G...

Interactive Elements Do Not Include

= Publish your documents online to the wek
[ *Publish Online’ after your PDF Exp...

Expert Adobe PDF

Adobe PDF Preset: | [Press Quality] (modified)

Standard: None v Compatibility: | Acrobat 5 (PDF 1.4)

Marks and Bleeds

Type: Default

Bleed and Slug
O Us cument Bleed Setti...

[J Include Slug A...

Step One
[llustrator: Windows > Save As
Indesign: Windows > Export

Step Two
Select Press Quality in ‘Adobe PDF
Preset.

Note: If your artwork has complex
special effects, we strongly advise
you choose Compatibility: Acrobat
4 (PDF 1.3). This will reduce the file
size and flatten your artwork.

Step Three
Under pages, ensure ‘Pages’ is
selected instead of ‘Spread’

Step Four

Under ‘Marks and Bleed’ section,
select ‘Crop Marks” and have a
minimum of 3mm in bleed settings,
(For all: Top, Bottom, Inside &
Outside).

=PLOT

eplot.com.au



Welcome to the evolution of print

2.7 Creating a Press Ready PDF

Export Adobe PDF

: Step Five

o TN Under ‘Output’ section, choose ‘No

colour conversion’ so that you don't

- include any colour profile in the

P sae oy ot ke ol 2 pdf and result in a different colour
() to the original design.

Qutput

Color

Color Conversion: | No Color Conversion

Description

Pasition the pointer aver 2 hesding to view = description.

Quality] (modified) i Step Six

v Compatibility: ' Acrobat 5 (PDF 1.4) v
You can save preset from the
e : bottom left hand corner for future
use.

Options: PDF Presst:

Wamings:

ummary... )
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2.8 Artwork delivery methods

« Upload your file to dropbox and share the file link with us by
emailing: info@eplot.com.au

« For further information on working with dropbox, please refer to
How to share Dropbox File.

« Otherwise email your file (max 10MB) to info@eplot.com.au
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More questions? Don't hesitate to ask!

The team at EPLOT are always happy to discuss any
technical aspects of your job. Please call us on
1300 660 228 or email info@eplot.com.au
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